










































































































































































































































































































































156 Fill, Lines, Colours, and Transparency 

 

 

The Opacity slider (Colour tab) can be 
used to alter the opacity of a specific 
colour, whether that colour is a solid fill 
(in an object or on a line), or a node's 
colour on a gradient fill path. Opacity 
can be applied locally to each object; the 
default is 100% opacity, i.e. the object is 
fully opaque. 

 

For solid fills, the opacity change will be made uniformly across the object's 
interior (see disc illustration). For gradient fill paths, different opacity levels can 
be assigned with colour along the fill path. The combination of different colours 
and semi-transparency allow interesting colour blends to be made. 
 

 

100% 
opacity 

(solid fill) 

50% 
opacity 

(solid fill) 

100%-0%-
100%-0%-

100% opacity 
(gradient 
fill path) 

 
Reducing the opacity on solid fills creates a blend between upper and lower 
object colours. Similarly, more complex colour blends occur along a gradient fill 
path when points along the path (called nodes) have reduced opacity settings. 

 Gradient fill paths are explained in detail in Working with gradient 
fills on p. 149.  

 Don't get confused between fill paths and transparency paths. The 
former is referred to here, but the latter is used to apply different 
levels of transparency along a transparency path instead of colour. 
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To apply solid opacity: 

1. Select the object(s) and display the Studio's Colour tab. 

2. Drag the slider to the left for a reduced opacity setting (e.g., 20%); drag 
right to increase opacity. This makes objects appear semi-transparent, 
or if set to 0%, fully transparent. 

 

To apply solid opacity (to a fill path): 

1. Select the object(s) and display the Studio's Colour tab. 

2. Click the  Fill Tool on the Drawing toolbar's  Fill flyout. 

3. Click on any displayed node along the fill path. Use Shift-select for 
selecting multiple nodes. 

4. From the Colour tab, drag the slider to the left for a reduced opacity 
setting. You'll notice the new opacity setting influencing the fill's 
appearance (if placed in front of another coloured object). 

Using transparency effects 
While uniform opacity can be applied along with colour via the Colour tab (see 
Setting opacity on p. 155), it's possible to apply gradient transparency via the 
Transparency tab or Transparency Tool independent of colour. Bitmap 
transparency can also be applied exclusively via the Transparency tab. 

Just as a gradient fill can vary from light to dark, a gradient transparency varies 
from more to less transparency, i.e. from clear to opaque. Picking a linear 
transparency preset from the Transparency tab, and applying it to a shape, 
shows the transparency effect. 

 

(A) Linear Transparency; (B) Transparency path; (C) Effect on graphic 























































































































































232 Creating Animations 

 

Flash Lite/i-Mode 

Use if you're intending to export a keyframe animation for mobile users 
operating mobile phones, personal organizers, and more. The format is 
optimized for viewing on smaller screen displays. The outputted file type is the 
same as that for Flash export, with a SWF file extension. 

To export to Flash Lite/i-Mode: 

1. Choose Export>Export as Flash Lite/i-Mode... from the File menu. 

2. From the dialog, provide a ShockWave Flash file name and folder 
location, and click the Save button. You'll see an export progress 
dialog appear until the file is created. 

Video 

Exported video formats include: 

• QuickTime. The QuickTime video and animation format (MOV) 
developed by Apple Computer. It can be read on many platforms, 
including Microsoft Windows (needs QuickTime Player) and of 
course on Apple computers. QuickTime supports most encoding 
formats, including Cinepak, JPEG, and MPEG. 

• Serif Transparent Video. The STV format is a useful proprietary 
format which can export animated text and logos with transparent 
backgrounds. The export benefits Serif MoviePlus users who would 
like to use their keyframe animation as an overlay (of titles, animated 
characters, etc.).  

• Video for Windows. The Windows Audio Video Interleave file (AVI)  
is ideal for playback on a Windows computer. Defined by Microsoft, it 
supports different types of video, audio and image sequences in sync 
with a mono or stereo sound track along with compression (via a wide 
variety of codecs). AVIs are mainly for viewing on a computer. 
Appropriate codecs have to be installed on the computer. 
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• Windows Media audio and Video. The WMV format is best 
supported on PCs running Windows Media Player, although some 
other software even on other platforms can play WMV video. WMVs 
are Advanced Systems Format (.ASF) files that include audio, video, or 
both compressed with Windows Media Audio (WMA) and Windows 
Media Video (WMV) codecs. 

To export animation as video: 

1. Choose Export>Export As Video... from the File menu. 

2. From the displayed dialog's Basic tab, select your chosen export type 
from the File type and Template drop-down list according to the type 
of output video format you require. 

3. (Optional) Click Match project settings to set an approximate video 
frame size based on your animation project's Page size (set in Page 
Setup). 

4. Specify a name for file in the Filename box, clicking Browse and 
selecting a new location if you first wish to choose an alternate drive or 
folder to store your file. 

5. (Optional) From the dialog's Advanced tab, make a new video 
template with the Copy button, then alter more advanced settings such 
as video Frame size (choose Custom then set a Width and Height), 
Pixel aspect ratio, Frame rate, Interlacing, Codec settings, and more, 
depending on the format to be exported. (See Exporting video 
(Advanced) in online Help for more details). 

6. (Optional) Set an export Quality. 

7. Click the Export button. Your project will then be composed and 
converted into the specified format and you will be shown a progress 
bar during this process. 



234 Creating Animations 

 

Image 

Within Stopframe animation, this option lets you create an animated GIF by 
default, which we'll focus on here. For keyframe animation, you can export a 
single keyframe as any type of image format. 

The .GIF format is ideal for web as it's universally supported by web browsers, 
and, as it's a multi-part format, it's capable of encoding not just one image but 
multiple images in the same file. A .GIF animation player or web browser can 
display these images in sequence, in accordance with certain settings (looping, 
frame delay, etc.) included in the file. The result—it moves! As with single-frame 
GIFs, if you opt to export your animation with the Transparency setting turned 
on, any unfilled regions of the graphic will become transparent in the GIF. All 
other regions will become opaque. For details on using transparency in GIFs, see 
Using transparency effects on p. 157. 

To export as an animated GIF: 

1. Choose  Export from the Frames tab. 

2. The Animated GIF format is pre-selected on the Format drop-down 
menu by default; if not, select it. If you choose another format, only 
the current frame will be exported. For full details on GIF export 
options, consult Exporting objects and drawings on p. 243. 

3. Set a size for the GIF animation and whether it is based on the whole 
Page, Selected Area or Selected Objects. Leave the dpi setting at 96 for 
standard screen resolution. 

4. On the Animation tab, which only appears in Stopframe Animation 
Mode, you can preview single frames or run the animation sequence, 
and make some final playback adjustments to the animation 
properties. 

5. Click the Export button (or Close to simply record the settings if you 
plan to preview in a browser first). 

6. Provide a file name and folder location, and click Save. Don't worry if 
you have extra white space around your image. Any unused border 
area will be cropped automatically, just as you saw in the Preview 
window. 
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Previewing the printed page 
Print Preview changes the screen view to display your layout without guides, 
rulers, and other screen items. Special options, such as tiled output or crop 
marks, are displayed. Depending on your currently set printer's capabilities, your 
preview will show in either greyscale or colour.  

To preview the printed page: 

• Choose Print Preview from the File menu. 

In Print Preview mode, the lower toolbar provides a variety of view options 
(from left to right): Zoom percent, Zoom Out, Zoom slider, Zoom In, the Zoom 
(region) Tool, Actual Size, and Fit Page. 

  

To print: 

• Click the Print button. 

To cancel Print Preview mode: 

• Click the Close button. 

Basic printing 
DrawPlus supports printing directly to a physical printer (e.g., All-in-ones, 
Inkjet and Laser printers) or to an electronic file such as Adobe Acrobat PDF. 
The printing feature allows scaling, tiling, and many other useful printing 
options for either method. 

For the moment we'll look at basic printing to "real" printers. However, if you're 
working with a service bureau or commercial printer and need to provide PDF 
output, see Publishing as PDF on p. 242.  
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To set up your printer or begin printing: 

• Click  Print on the Standard toolbar.  

The Print dialog appears. 

To print:  

1. On the General tab, select a printer from the list. If necessary, click the 
Properties button to set up the printer for the correct page size, etc. 
Set the page size from the Advanced button. Depending on your 
printer driver, to print text with shading or custom settings, enable the 
"Send True Type as Bitmap" option. 

2. If necessary, click Layout to set options for scaling, thumbnails, multiple 
pages, or tiling. For details, see Printing special formats (on p. 239) 

3. Select the print range to be printed—choose the whole document, 
current page, selected pages/page ranges as options. 

4. Select the number of copies. 

5. If required, save the current settings to a Print profile (see p. 238). 

6. Click OK.  

The Preview window shows how your document maps to the selected paper size. 

The pages will be printed in colour on a colour printer or in shades of grey on a 
black and white printer. 

You can save the current combination of settings made in the Print dialog as a 
print profile with a unique name. Note that the profile includes settings from all 
tabs except the Separations tab. (By the way, don't confuse these DrawPlus "print 
profiles" with ICC "device profiles."). 

To save current print settings as a print profile:  

1. On the Print dialog's General tab, click the Save As... button next to 
the Print Profile list. 

2. Type in a new name and click OK. 

The settings are saved as a file with the extension .PPR. 

You can restore the profile later on simply by choosing its name in the list. 
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Printing special formats  
In Normal drawing mode, using Page Setup and printing options, you can set up 
pages for a variety of document types, such as Special Folded documents 
(greetings cards), Large documents (posters and banners), and Small documents 
(business cards, labels, tags). The Print dialog's Layout tab lets you specify other 
printing options, including scaling, thumbnails, multiple pages, and tiling. 

Folded documents 

DrawPlus automatically performs imposition of folded documents (cards, 
menus, etc.) for "Special Folded" document types. The settings ensure that two, 
three or four pages of the document are printed on each sheet of paper, with 
pages printed following the document sequence. This saves you from having to 
calculate how to position and collate pairs of pages on a single larger page, and 
lets you use automatic page numbering for the various pages. 

The types most appropriate to invitations and greeting cards, include Tent Card, 
and Side/Top Fold Menu, Top Fold-Quarter size, Tri-Fold, or Z-Fold. 

To produce double-sided sheets, check the Balanced option (for balanced 
margins) in Page Setup, then your printer's double-sided option or run sheets 
through twice, printing first the front and then the back of the sheet (reverse top 
and bottom between runs). 

Printing posters and banners 

Posters and banners are large-format documents where the page size extends 
across multiple sheets of paper. To have DrawPlus take care of the poster 
printing, set up your document beforehand using File>Page Setup... (with the 
"Large" document type option) to preview and select a particular preset 
arrangement (e.g., choose orientation).  

Even if the document isn't set up as a poster or banner, you can use tiling and 
scaling settings (see p. 240) to print onto multiple sheets from a standard size 
page. Each section or tile is printed on a single sheet of paper, and the various 
tiles can then be joined to form the complete page.  
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To print a poster or banner from a standard size page: 

1. First create your standard sized page (e.g., A4). 

2. On the Print dialog's Layout tab, check Print tiled pages for 
overlapped multiple sheets. 

3. Set the As in document "% Scale factor" to print at a larger size (e.g. 
300%). 

Printing business cards and labels 

While DrawPlus can deal with large-format documents it is equally suited to 
documents where the design can be repeated multiple times on the same page 
during printing. Set up your drawing beforehand using File>Page Setup... (with 
the "Small" document type option) to preview and select a particular preset 
arrangement. 

At print time, you can set the "Multiple pages per sheet" option to Repeat pages 
to fill sheet, Each page N times or Full sheet of each page in the Print>Layout 
tab. You can tell DrawPlus to skip a certain number of regions on the first sheet 
of paper—useful if, for example, you've already peeled off several labels from a 
label sheet, and don't want to print on the peeled-off sections. 

 If you haven't set up the drawing as a Small Drawing, but still want 
to print multiple pages per sheet, try using the Fit Many option. 

Printing thumbnails 

• Under "Special Printing" on the Print dialog's Layout tab, set the "Print 
as thumbnails" option to print multiple pages at a reduced size on each 
printed sheet, taking printer margins into account. Specify the number 
of thumbnails per sheet in the value box. 

DrawPlus will print each page of the document at a reduced size, with the 
specified number of small pages or "thumbnails" neatly positioned on each 
printed sheet. 
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Multiple pages per sheet 

• Under "Multiple Pages per Sheet" on the Print dialog's Layout tab, 
select an option.  

The multiple page options are enabled when you are working with a page from 
the "Small" documents category in Page Setup. You can select the number of 
times to repeat each page, and tell DrawPlus to skip a certain number of regions 
on the first sheet of paper. Skipping regions is useful if, for example, you've 
already peeled off several labels from a label sheet, and don't want to print on the 
peeled-off sections. Display the Preview window to see how the output will look. 

• If you haven't set up the document as a Small document, but still want 
to print multiple pages per sheet, try using the Fit Many option (see 
"Scaling" on p. 240). Note that this option ignores printer margins and 
doesn't change the imposition (orientation) of output pages. 

Tiling 

• Under "Tiling" on the Print dialog's Layout tab, check Print tiled 
pages to print large (or enlarged) pages using multiple sheets of paper. 

• Set the % Scale factor to print at a larger size (e.g. 300%) 

Each section or tile is printed on a single sheet of paper; the various tiles can 
then be joined to form the complete page. Use this option for printing at larger 
sizes than the maximum paper size of your printer, typically for creating banners 
and posters. To simplify arrangement of the tiles and to allow for printer 
margins, you can specify a Tile overlap value. 

 Margins are included in tiling calculations. 
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Publishing as PDF 
PDF (short for Portable Document Format) is a cross-platform WYSIWYG file 
format developed by Adobe to handle documents in a device- and platform-
independent manner. The format has evolved into a worldwide standard for 
document distribution which works equally well for electronic or paper 
publishing. 

Although PDF excels as an electronic distribution medium it is also an excellent 
format for delivering a drawing file to a professional printer using PDF/X 
formats, targeted for graphic arts and high quality reproduction. Your print 
partner can tell you whether to deliver PDF/X-1 or PDF/X-1a (DrawPlus 
supports both)—but from the DrawPlus end of things you won't see a difference. 
In either mode, all your drawing's colours will be output in the CMYK colour 
space, and fonts you've used will be embedded. A single PDF/X file will contain 
all the necessary information (fonts, images, graphics, and text) your print 
partner requires. 

If professional printing is required, you'll need to select Prepress options (via the 
Print dialog's Prepress tab) before choosing to output your drawing. 

To export your document as a PDF file:  

1. Prepare the document following standard print publishing guidelines, 
taking the distribution method into account. 

2. Choose Publish as PDF... from the File menu and check your export 
settings. (To export the whole document using default settings, you won’t 
need to change any settings.) Make further last-minute changes (for 
example, a custom setting required by your print bureau). 

3. Review General, Prepress, Compression, Security, and Advanced tab 
settings and modify if necessary (see online Help for more details). 
 
When preparing a PDF/X file for professional printing, choose either 
"PDF/X-1" or "PDF/X-1a" in the General tab's Compatibility drop-down list 
(General tab), as advised by your print partner. 
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Also inquire whether or not to Impose pages; this option is fine for desktop 
printing of a folded drawing or one that uses facing pages, but a 
professional printer may prefer you to leave the imposition (page 
sequencing) to them. 
 
If you checked the General tab's Preview PDF file option, the resulting PDF 
file appears in the version of Acrobat Reader installed on your system. 

4. Click OK to proceed to export.  

Exporting objects and drawings 

 

When you save a drawing, DrawPlus 
uses its own proprietary formats (.dpp 
for drawings, .dpx for templates and 
.dpa for animations) to store the 
information. From these formats it is 
possible to export your drawing as a 
graphic in order to read the drawing 
into another application or use it on a 
web page. A choice of graphics formats 
can be exported. 
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You can export at any time by using Export as Image or Dynamic Preview; the 
latter option allows editing during preview—great for pixel-accurate editing of 
your intended output. You can even compare side-by-side views using different 
export settings. 

 For converting DrawPlus objects into pictures on the page, use 
Tools>Convert to Bitmap.... 

 For export as AutoCad drawings, use Export>Export for CAD/CAM 
on the File menu. 

Exporting as image 

Especially if you're exporting web bitmap images, you can take advantage of the 
Image Export dialog, which will greatly help you in reducing file sizes and 
download times as far as possible while maintaining image quality. The dialog 
lets you export the whole page, just a selected object(s) or a user-defined region. 
You can also see how your image will look (and how much space it will take up) 
before you save it! For visual comparison, its multi-window display provides 
side-by-side WYSIWYG previews to compare different image formats, or the 
same format at differing bit depths.  
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To export as an image: 

1. Choose Export>Export as Image... from the File menu. 

2. (Optional) From the Export Area section, you can scale the image to a 
new size if desired (change pixels), or adjust the dpi (dots per inch) 
setting. For graphics to be used on-screen, it's best to leave these values 
intact. The export can be based on the whole Page, Selected Area (see 
Defining a region for export on p. 246), or Selected Items. 

3. From the Properties section, select the intended graphics file format 
from the Format drop-down menu. The remaining box area will 
display different options depending on your chosen graphics format. 
Change settings as appropriate to the file format selected (see online 
Help for more information). 

4. (Optional) From the Web Options section, you can control web 
elements in your image.  

• You can uncheck Image Slices or Hotspots if you've create these 
elements but don't want them exported. 

• Click the Estimate Download Time...  button to see how long the 
image will take to download using various connections. In the 
dialog, select a modem type (from 14.4 Kbps to 1.5 Mbps) in the 
list and the value updates immediately. You may want to keep 
track of the cumulative values for multiple images on a given 
page. 

5. Click Export. If you click Close, DrawPlus remembers your preferred 
format and settings, particularly useful for adjusting the setting which 
are used if you preview the image in a browser (using File>Preview in 
Browser). 

 When exporting Stopframe animations, an Animation tab is shown 
in the dialog for frame export control. 
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Defining a region for export 

 

DrawPlus lets you export a specific region in 
your design. The region, shown as a 
bounding box, is actually a layer overlay 
which can be resized, repositioned over the 
export area and shown/hidden. The Image 
Export dialog is used for the actual export 
process.  

To define an export region:  

1. From the Standard toolbar, click  Overlays and select Export 
Overlay from the drop-down menu. A bounding box is overlaid over 
your page. 

2. Drag a corner (or edge) handle to resize the box (use the Ctrl key as 
you drag to resize the box about its centre); reposition the box over the 
export area. 

3. (Optional) Name the Export Overlay layer in the Export Name box on 
the context toolbar (this labels the export overlay in the Layers tab and 
provides the default file name at export). 

4. Click Export... shown under the box. The Image Export dialog is 
displayed, from which you can modify and choose an export file 
format (described previously). 

When the overlay is applied, the bounding box is automatically selected (it 
shows the selection colour of the overlay layer). Clicking away from the box will 
deselect it (showing the box Colour), but it can be reselected at any time (e.g., for 
repositioning). 

To select the box: 

• From the Standard toolbar, click  Overlays and click Export 
Overlay. 
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Dynamic preview 

Although the Image Export dialog's preview options lets you see how your 
export will look, it's time-consuming to repeatedly export your graphic until you 
get the output exactly as you want it. Instead, you can use Dynamic Preview, 
which lets you swap to a preview-and-edit mode, showing how your graphics 
will export directly on the page. It also lets you edit that output while still 
previewing, and set up the exported file's name, format and other settings. The 
ability to fine-tune object positioning to pixel level gives an added advantage for 
web graphics developers.  

To change export settings: 

1. From the HintLine toolbar, click the  Dynamic Preview down 
arrow and choose Preview Settings.... The option launches the 
Dynamic Preview Options dialog, which closely resembles the Image 
Export dialog (see p. 244). 

2. (Optional) From the Export Area section, scale the image to a new size 
if desired (change pixels), or adjust the dpi (dots per inch) setting. 

3. Change settings in the Properties box according to your chosen 
Format. Settings change according to file type (see online Help for 
more information). 

4. Click OK. 

To export via Dynamic Preview: 

1. From the HintLine toolbar, click the  Dynamic Preview down 
arrow and choose Export Preview As.... 

2. From the dialog, you'll be prompted for a file name to which you can 
save your graphic. Choose a folder location and enter a file name. 
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To toggle between Normal and Preview Mode: 

• Click  Dynamic Preview on the HintLine toolbar. If you've 
multiple documents loaded, you'll notice the current document's tab at 
the top of your workspace indicate the change to preview mode.  
 

 
 
To revert to Normal mode, click Dynamic Preview again. 

While in this mode, any object can be manipulated or modified as if you are 
working in normal drawing mode, but what you're seeing is an accurate 
portrayal of your graphic to be exported. 
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Sharing via DRAWPLUS.COM 

 

You can share your design by print, as a 
distributable electronic PDF, or via the 
drawplus.com website. Publishing your design 
to website means you can share your design 
and ideas with a community of like-minded 
designers! 

The drawplus.com website is designed specifically as a design community. By 
uploading your completed design to the website, just like other DrawPlus users 
do, you add to the collection of published designs in the community. 

The main website features include: 

• View published designs 
To aid your design skills or to browse for fun, use the Wall design 
gallery which "showcases" public designs published by other DrawPlus 
users (...and yourself!). Take advantage of awesome zoom technology 
coupled with pan and zoom control. Easily view your own, the most 
recently uploaded, and featured designs. 

• Drawing ratings 
Rate and comment on other people's designs—and have your own 
design assessed by the community! 

• Work in groups 
Create groups of users with similar interests—great for schools, clubs, 
or maybe just your network designing friends. Use the Group Wall to 
view published designs in a chosen group, which can be private, public 
or "friends only." Post to group forums restricted to just group 
members.  

• Search 
Find designs, groups, or other designers throughout the website. 
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• Make new friends! 
Social networking meets designing! Use email or user discussion 
forums to build friendships with other DrawPlus designers, especially 
those you add to your friends list. Even upload photos of yourself! 

• Profile management 
Manage your tagline, password, timezone, language, and email 
notifications. 

To share, three stages need to be carried out—register on the website, setup 
account information in DrawPlus, and then upload your chosen design to the 
website. 

Registering for the first time 

1. Click  Share on the Standard toolbar. 

2. If you've not registered before, click the Join Now! button. You'll be 
taken directly to drawplus.com registration. 

3. From the website's registration form, enter your personal information, 
including an email address to which an activation message will be sent. 
Use the Help button if needed. 

4. Click Create Account. For account activation, you'll need to check 
your email and click on the activation message sent to you. This may 
take time depending on your ISP and connection! 

 Remember your Username and Password! You'll need to re-enter 
this information into DrawPlus.  

5. Registration is complete after activation. All that's now required is to 
enter your account details into your DrawPlus program. 
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If you've already registered but not added your account details, click Login. This 
takes you to your account details where you can enter details as described in the 
next section. 

 So you don't forget to set your user account details, you'll get a 
reminder to register every eight days if there are no details set. You 
can register on the website, then transfer your username and 
password over, or cancel to register later.  

Setting up account details in DrawPlus 

1. Select Options... on the Tools menu. 

2. In the Options>Upload pane, enter your remembered Username and 
Password. 

3. (Optional) click the Test button to verify that the account details are 
correct. If successful, a "Username and password valid" message is 
produced. 
 
If you've forgotten your password or you've not already registered, use 
the accompanying Reset Password and Register buttons. For the 
latter, you'll be directed to the Registration page on the website. 
Complete the registration details and click Create Account. 

4. (Optional) Reduce the upload Quality to 96dpi to speed up file 
transfer if your Internet connection is 56k dial-up modem (at the 
expense of zoom quality). Otherwise, use the default 300 dpi for 
broadband and all other faster Internet connections. 

 If you change your account details on the website at a later date, 
you'll also need to make these account changes in DrawPlus.  
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Uploading 

Once you've successfully created your account you can upload your design, with 
the option of including only specific or all pages. 

 

To upload your design: 

1. On the Standard toolbar, click  Share. 

2. In the Share dialog, uncheck pages you don't want to upload (use the 
scroll bar for more than three pages). 

3. (Optional) For the upload you can choose a different account to 
upload to—enter a different Username and Password. Otherwise, any 
previously used account will be remembered.  

4. Click Upload to transfer your selected pages. 

5. On upload, a progress bar indicates upload status. On completion, 
click OK to close the dialog or click View to immediately see your 
uploaded design on the website.
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Pressure sensitivity 
When painting, or drawing lines and curves, DrawPlus lets you take advantage 
of pressure sensitivity in a variety of ways: 

•  via an installed pen tablet.  

• via the Pressure tab (if pen tablet is unavailable). 

via a pen tablet 

Your pen tablet and DrawPlus work in perfect harmony for a truly authentic 
drawing and painting experience, with in-built pressure sensitivity as you draw 
and paint. See Using pen tablets (p. 259) for more information.  

via the Pressure tab 

If a pen tablet is unavailable to you, DrawPlus can simulate pressure sensitivity 
when using your mouse (along with DrawPlus’s Pressure tab). 

 

This tab is used to set pressure sensitivity globally by using a pressure profile. 
The tab lets you:  

• Select a preset pressure profile 

• Create your own custom profile from scratch 

• Adjust how brush, pen, or pencil width and transparency changes as 
it responds to pressure 

• Control the maximum and minimum pressure. 
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The pressure chart may appear a little daunting at first! It becomes a lot clearer if 
you imagine the chart when it is superimposed over a brush itself—it represents 
one half of a brush stroke along its entire length exactly. Of course, the same 
profile shape will be mirrored on the lower half of the stroke. 

 

 The same would apply to a pencil or pen stroke. 

To apply a pressure profile:  

1. Expand the Pressure tab at the bottom right of your screen, and choose 
a pressure profile from the drop-down list. 
 

 
 
The pressure chart updates to reflect the chosen profile. 

2. Apply a brush stroke or draw a line on the page. This will adopt the 
chosen pressure profile. 

The profile is maintained until you reset it or pick another profile from the 
preset list. 

To create a new pressure profile: 

1. Click  Reset Pressure Profile. This sets the pressure chart back to 
default. 

2. A turquoise line runs along the maximum pressure line at the top of 
the chart. Click on this line (the cursor changes) and drag downwards, 
moving the displayed red node into your chosen position. You now 
have a blue curve which represents the pressure profile. 

3. Repeat the process for the number of nodes that you want to add to 
make up the profile. 
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 Edit an existing pressure profile from the preset drop-down menu to 
create profiles quickly. 

You can save the current pressure settings to your own saved pressure profile—
this allows you to store and reapply your settings at any point in the future. 

To save a new pressure profile: 

• Click the tab's  Tab Menu and select Add Pressure Profile. 

Your new profile is automatically added to the bottom of the drop-down list. 

To delete a pressure profile: 

1. Click the tab's  Tab Menu and select Manage Pressure Profiles.... 

2. In the dialog, select the pressure profile for deletion and click Delete. 

Altering stroke width and opacity with pressure 

For subtle pressure control, DrawPlus can vary the extent to which pen pressure 
can alter the width and opacity of a brush stroke or drawn line. This is expressed 
as a percentage of the original stroke's Width and Opacity values shown in the 
Brushes context toolbar (or equivalent for pen or pencil lines). Imagine the end 
of your stroke tapering off or getting fainter as it lifts off the page. 

The width and opacity setting can be set either: 

• globally, via the Pressure tab. 
 
- or - 

• per brush, via the Stroke Brush Edit or Spray Brush Edit dialogs.  

You can set the degree to which width and opacity changes either independently 
or in combination. Let’s look at some examples... based on drawn straight line 
for clarity. We’ll use a pressure profile (below) available from the preset drop-
down menu for all examples. 
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Here’s how the degree of width/opacity changes the stroke's appearance. 

Pressure tab Brush Edit dialog Result 

 

Width: 100% 
Opacity Variance: 100% 

 

 

Width: 0% 
Opacity Variance: 100% 

 

 

Width: 100% 
Opacity Variance: 0% 

 

 

Width: 0% 
Opacity Variance: 0% 

 

 

Width: 50% 
Opacity Variance: 50% 

 

 
The first example shows the default behaviour when pressure is applied. 

 These settings are stored independently of the currently chosen 
pressure profiles. 

To adjust stroke width or opacity with pressure (in Pressure tab): 

1. Select a previously drawn brush, freeform line, or curve. 

2. In the Pressure tab, pick a pressure profile from the drop-down menu. 

3. Enter a  Width or  Opacity value by setting a percentage value 
in the input box, using the slider or using the up/down arrows. The 
lower the value the less the pressure effects the stroke width or opacity, 
i.e. a value of 50% will apply half the stroke width or opacity under 
pressure. 
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For some preset brushes, stroke width and opacity are set differently to (and 
override) the Pressure tab's global settings. This is to more accurately represent 
the inherent characteristics of that particular brush. It is possible to adjust these 
settings further or to apply settings to a brush currently without such settings. 

To adjust stroke width or opacity with pressure (per Brush): 

1. Right-click on a brush in a Brush tab's category, and select Edit.... 

2. In the Brush Properties section, check the Initialize creation tools.. 
option. 

3. Set Variance values for Width and Opacity. 

4. Click OK. Any new stroke using the edited brush will adopt the new 
settings.  

You can also set the pressure variance, i.e. the degree to which you apply 
pressure, via the Pressure tab or per brush. (See online Help for more 
information.)  

Using pen tablets 
You can either draw or paint with your mouse or, for a more natural experience, 
use a pen tablet. A pen tablet is comprised of an intelligent electronic pad 
equipped with a pressure-sensitive pen. A rectangular “active” area responds to 
pressure applied by the input device (e.g., Pressure Stylus). 

The pad, when connected to your computer, allows realistic sketching, freehand 
line drawing and painting within DrawPlus, making the drawing experience as 
close to a pencil, pen, or paintbrush as you can get. The tablet’s pressure-
sensitive capabilities in conjunction with DrawPlus allows control of stroke 
width or transparency when drawing or painting.  

DrawPlus works equally well from entry-level to professional pen tablets from all 
the major tablet manufacturers including Wacom and AipTek. 

Within DrawPlus, you can use the Pressure Studio to calibrate your tablet's 
pressure response and to customize your own assignments for your tablet's 
ExpressKeys*, TouchStrip*, or TouchRing*. DrawPlus settings take precedence 
over your device's original settings.  

* Not available on some pen tablets.  
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Using Pressure Studio 

DrawPlus's Pressure Studio acts as an interface between your tablet and 
DrawPlus, purposely designed to: 

• Calibrate pressure response (below) for multiple input devices, so that 
DrawPlus tools respond more predictably per device. 

• Set up your tablet's key assignments from within DrawPlus (if your 
tablet supports function keys). 

 

The studio offers: 

• A practise area for automatically calibrating your tablet's input 
devices (Pressure Stylus, Eraser, Airbrush, etc.) by drawing soft/firm 
strokes. Manual calibration for fine-tuning is also possible. As you 
swap between each device (e.g., between pen stylus and eraser) the 
pressure response curve for that device is displayed accordingly. 

• Management of pressure response profiles. Preset profiles are 
available to resolve common problems associated with unexpected 
pressure response. 
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• Disabling of pressure input globally, to allow DrawPlus to operate 
without tablet pressure sensitivity.  

To launch Pressure Studio: 

• Select  Pressure from the Standard toolbar. The Pressure 
Studio is displayed. 

 Before calibration, practise drawing with your input device in the 
practice area! 

The calibration process is described in detail in the online Help. 

Function key assignment 

If your pen tablet is equipped with ExpressKeys (or equivalent), Pressure Studio 
lets you assign your tablet's keys to DrawPlus tools. The studio changes 
depending on the type of pen tablet installed, so you'll get an accurate 
representation of your pen tablet's key layout shown within Pressure Studio's 
Functions tab. 

 
 
Example of Wacom Intuos 3's ExpressKey assignment in DrawPlus. 
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To customize your function keys: 

1. With the Functions tab in view, select an alternative tool from the 
drop-down list. Pressing the appropriate key on your tablet will 
activate that tool in DrawPlus. 
 

 
 

2. Click OK. 

 The Functions tab is not shown if your tablet doesn't possess 
function keys. 

To revert to the tablet's default key assignment: 

1. Select the "Tablet Default" option from a specific key's drop-down list 
 

 
 

2. Click OK. 



 

 

Index 14 



264 Index 

 



Index 265 

 

 

2D 
filter effects, 189 

3D 
filter effects, 192 
Instant, 196 
Lighting, 195 
planes, 199 
Pseudo, 199 

actions (Keyframe animation), 224 
Actions tab, 212 
ActionScript, 225 
Add/Delete Pages, 42 
Adobe Acrobat (pdf files), 242 

importing, 14, 24 
publishing, 242 

Adobe Illustrator (opening), 26 
aesthetic proportioning, 49 
airbrushes, 87 
Align tab, 126 
alignment, 98 

of objects, 126 
of text, 98 

Alpha-edged bitmap, 166 
animation, 205 

exporting, 231 
Keyframe, 205, 211 

actions in, 224 
adding movies to, 217 
adding sound to, 217 
Autorun in, 223 
exporting, 231 
markers in, 227 
non-linear change over 

time, 228 
object attributes in, 221 
object control in, 219 

object placement in, 221 
previewing, 218 

Stopframe, 205, 207 
exporting, 231 
onion skinning in, 209 
previewing, 210 

Animation Mode, 205 
artistic text, 95, 97 
Artistic Text Tool, 96 
audio clips (Keyframe animation), 

217 
Auto Connectors, 76 
AutoCAD 

opening, 27 
Auto-Select Layer, 133 
AutoTrace Studio, 170 
autotracing, 169 
AVI format, 232 

for animation, 232 
Back One, 128 
background (page), 45 
banners, 239 

printing, 239 
setup, 31 

Bevel effects, 189 
Bézier curves, 62, 69 

editing, 69 
Bitmap brushes, 87 
Bitmap fills, 137, 152 
Bitmap transparency, 158 
bitmaps 

Alpha-edged bitmap, 166 
Vector-cropped bitmap, 166 

bleed limit, 242 
in printing, 242 

Blend Mode, 12, 141 
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Blend Tool, 184 
blending, 184 

stopframe animation, 186 
blur, 191 
blur effects, 190 
Border Wizard, 183 
borders, 183 

creating, 183 
Bring to Front, 128 
brush strokes, 12, 89 

applying, 89 
editing, 91 

brushes, 13 
altering opacity with pressure, 

257 
altering width with pressure, 

257 
textured, 87 

Brushes tab, 87 
business cards, 240 
camera 

TWAIN-compatible, 180 
canvas 

resetting, 47 
rotating, 46 

cards 
business, 240 
printing, 239 
setup, 31 

changing views, 42 
Choose Workspace, 20 
Clipboard operations, 107 
clipping, 124 

Clip to Bottom, 124 
Clip to Top, 124 

cloning, 107 
closed lines (shapes), 63 
closing DrawPlus, 28 

Colour Fill, 190 
colour models, 147 
Colour Picker Tool, 13, 144 
Colour tab, 14, 137, 147 
colours, 149 

colour contour (gradient fills), 
149 

defining, 13, 146 
key colours (gradient fills), 149 
sampling, 144 
solid for lines and fills, 146 

Combine, 124 
conical fills, 149 
conical transparency, 158 
connection points, 76 
Connector Tool, 13, 77 
connectors, 76 

types of, 79 
control handles (line editing), 69 
Convert to 

Curves, 73 
Keyframe Animation, 206 
Stopframe Animation, 206 

Create 
Keyframe Animation, 205 
Stopframe Animation, 205 

crop marks (printing), 242 
Crop Tool, 110 
cropping, 124 

Crop to Bottom, 124 
Crop to Top, 124 

curved lines, 62 
curved text, 101 
curves 

drawing, 62 
filling unclosed, 63, 64 
redrawing, 65 
reshape, 66 
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cutting objects, 107, 114 
cutting out pictures, 165 

output for, 166 
selecting areas for, 167 

defaults 
manually setting, 53 
resetting, 53 
synchronize, 51 
updating, 51 

design aids, 46 
divine proportions, 49 
multiple windows for, 50 
rotating canvas, 46 
rule of thirds, 47 
solo mode, 50 

design templates, 20 
dimension lines, 80 
Dimension Tool, 14, 81 
dimensionality (Instant 3D), 196 
dimensions, 33 

setting units and scale, 31, 36 
distribution 

of objects, 127 
divine proportions, 49 
Document Palette, 14, 146 
documents 

closing, 28 
creating with design templates, 

20 
exporting, 243 
opening saved, 22 
saving, 27 
starting new, 21 
types, 31 
working with layers, 128 

download time estimator, 245 
DPA format, 27 
DPP format, 27 

DPX format, 27 
drawing scale, 33 

setting, 36 
drawings 

closing, 28 
creating with design templates, 

20 
exporting, 243 
opening saved, 22 
perspective, 74 
saving, 27 
starting new, 21 

drop shadows, 187, 189 
Duration (animation frames), 231 
DWG/DXF files 

opening, 27 
Dynamic guides, 37, 40 
Dynamic Preview, 247 
Easing tab, 212 
edges, 143 
Edit All Layers, 133 
Edit Text window, 98 
editing, 97 

brush strokes, 91 
connectors, 76 
curves, 65 
lines and shapes, 65 
QuickShapes, 73 
text, 97 

effects 
2D, 189 
blends, 184 
borders, 183 
curved text, 101 
envelopes, 75 
feathering, 191 
filters, 189, 192 
Instant 3D, 196 
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outline, 190 
perspective, 74 
Pseudo 3D, 199 
roughening edges, 186 
shadows, 187 

Effects tab, 192 
ellipse fills, 149 
ellipse transparency, 158 
Emboss effect, 189 
Envelope Tool, 75 
envelopes, 75 

in Keyframe animation, 228 
Erase Tool, 117 
estimating download time, 245 
Export Optimizer, 12, 231, 243 
exporting, 231, 242 

animations, 231 
drawings, 243 
HD photos, 245 
objects, 243 
overlays, 246 
PDF files, 242 
Serif Metafiles, 245 
via Live Export Preview, 247 

Feather Edge, 189 
Feather effect, 190 
feathering, 191 
features 

existing, 4 
new, 12 

fill path 
bitmap and plasma fills, 153 
gradient fills, 151 
mesh fills, 154 

Fill Tool, 149, 152 
Fill-on-Create, 63, 90 
fills, 137 

applying solid, 138 

Bitmap and Plasma, 152 
Bitmaps, 137 
changing, 149 
gradient, 137, 149 
mesh, 154 
plasma, 137 
setting defaults, 51 
solid, 137 

defining, 146 
filter effects, 12, 189, 192 
filters 

applying, 175 
Flash Lite export, 232 
Flash SWF export, 231 
Flip Horizontal, 122 
Flip Vertical, 122 
focused design, 50 
folded documents 

printing, 239 
setup, 31 

fonts, 97 
embedding in PDF files, 242 

Format Painter, 113 
formatting, 97 

of text, 98 
Forward One, 128 
four colour fills, 149 
four points transparency, 158 
frame text, 95, 97 
Frame Text Tool, 96 
Frames tab, 207 
Freeform Paint Tool, 118 
freezing (layers), 131 
gallery, 83 
Gallery tab, 83 
Gaussian blur, 190 
GIF, 234 

for animation, 234 
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Glow effects, 189 
gradient fills, 14, 137, 149 
gradient transparency, 158 
graphics tablet, 259 
greetings cards, 239 
grid 

show or hide, 40 
snapping, 40 

grouping objects, 123 
guides 

Dynamic, 37, 40 
ruler, 35 
snapping to, 37 

Image Cutout Studio, 165 
images (see pictures), 163 
i-Mode export, 232 
importing 

PhotoCDs, 164 
pictures, 163 
scanned images, 180 
Serif Metafiles (smf), 163 

imposition, 242 
in PDF publications, 242 
of folded documents, 239 

Inner Bevel effect, 189 
Inner Glow effect, 189 
Inner Shadow effect, 189 
installation, 15 
Instant 3D, 196 
interface 

changing views, 42 
guides, 35 
page and pasteboard, 32 
rulers, 33 
snapping grid, 37 

Join Curves, 71 
key colours (gradient fills), 149 

key objects (Keyframe animation), 
205, 211 

keyboard shortcuts, 12 
Keyframe Animation, 205, 211 
keyframes, 205, 211 

changing duration of, 216 
inserting, 215 
object control in, 219 
splitting, 215 

Knife Tool, 114 
lasso selection, 59 
layers, 128 

adding, 129 
deleting, 130 
freezing, 131 
locking, 131 
managing objects on, 131 
merging, 131 
paper textures on, 131, 195 
properties of, 131 
rearranging, 130 
renaming, 129 
selecting, 129 

Layers tab, 129 
layout tools, 33, 37 

guides, 35 
page and pasteboard, 32 
rulers, 33 
snapping grid, 37 

levels (object order), 127 
lighting effects (3D), 195 
Line tab, 141 
linear fills, 149 
linear transparency, 158 
lines 

adding line styles, 142 
applying settings, 141 
closed (shapes), 63 
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closing, 64 
connectors, 76 
curved, 62 
defining colours, 146 
dimension lines, 80 
drawing, 60 
editing, 65 
extending, 62 
filling unclosed, 63 
joining, 71 
reshaping, 66 
setting defaults, 51, 141 
smoothing, 61 
straight, 61 
styles for, 142 

Lock Position, 122 
margins of page, 31 
markers (Keyframe), 227 
marquee selection, 57 
Material Thickness, 189 
measurement units, 33 
Mesh Fill Tool, 154 
mesh fills, 154 
metafiles, 163 
morphing (blends), 184 
Motion blur, 190 
movies (Keyframe animation), 217 

adding, 217 
moving objects, 114 
multiple pages, 239 

printing, 241 
multiple selections, 57, 58 
multiple windows, 50 
New Drawing, 21 
new features, 3, 12 
Node Tool, 57, 66, 72 
nodes 

editing, 66 

Nudge Distance (arrow keys), 114 
objects 

adding to, 117 
aligning with each other, 126 
aligning with snapping grid, 37 
cloning, 107 
converting shapes to editable 

curves, 73 
copying formatting, 113 
copying, cutting, and pasting, 

107 
cutting, 114 
deleting, 107 
distributing, 126 
editing Bitmap and Plasma fills 

on, 152 
editing gradient fills on, 149 
editing mesh fills on, 154 
erasing, 117 
exporting, 243 
fills, 137 
flipping, 122 
grouping and ungrouping, 123 
isolating, 50 
joining, 125 

Add, 125 
Intersect, 125 
Subtract, 125 

key (Keyframe animation ), 211 
line settings, 141 
locking/unlocking, 122 
measuring, 33, 80 
moving, 114 
naming, 133 
obstructive, 79 
on layers, 133 
ordering, 127 
outlines, 143 
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brush effects, 143 
edge effects, 143 

properties, 12 
QuickShapes, 72 
replicating, 108 
resizing, 118 
rotating and shearing, 120 
scale, 33 
selecting complex objects, 59 
selecting one or more, 57, 123 
selecting, in groups, 123 
setting defaults, 51 
shearing, 121 
splitting, 114 
storing in Gallery, 83 
transparency effects on, 157 
tweened (Keyframe animation), 

211 
obstructive objects, 79 
onion skinning (Stopframe), 209 
opacity, 155 
opening 

AutoCAD files, 27 
DWG/DXF files, 27 
PDF files, 14, 24 
picture as a document, 24 
saved documents, 22 

optimizing exported graphics, 243 
ordering objects, 127 
Outer Bevel effect, 189 
Outer Glow effect, 189 
Outline effect, 190 
outlines, 143, 190 

brushes as, 143 
edge effects for, 143 

overflow (of text), 99 
overlays 

as design aids, 46 

page 
area, 32 
composition, 46 
marks (printing), 242 
numbers and navigation, 42 
size, 31 
units, 31 

Page Setup, 31, 206 
page units, 33 
pages, 44 

adding, 44 
backgrounds for, 45 
deleting, 44 
duplicating, 44 

Paintbrush Tool, 87, 89 
palettes, colour, 147 
paper textures, 131, 195 
pasteboard area, 32 
PDF files, 242 

importing, 14, 24 
publishing, 242 

pen tablet, 13, 259 
Pen Tool, 60, 62 
Pencil Tool, 60 
perspective, 74 
Perspective Tool, 74 
PhotoLab, 14, 173 

applying filters, 175 
retouching, 177 
selective masking, 177 

pictures 
adjusting, 173 
adjustments for, 173 
as bitmap fills, 152 
converting to vector format, 170 
cutting out, 165 
effects for, 173 
fixing red eye, 173 
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importing, 163 
importing PhotoCD images, 164 
importing TWAIN images, 180 
in PDF files, 242 
open picture as a document, 24 
tracing, 169 
with transparent regions, 165 

Pillow Emboss effect, 189 
plasma fills, 14, 137, 153 
plasma transparency, 158 
Pointer Tool, 57 
posters, 31, 239 

printing, 239 
setup, 31 

PostScript, 242 
prepress print options, 242 
pressure sensitivity, 13, 255 
Pressure tab, 255 
previewing, 231, 237 

graphics dynamically, 247 
Keyframe animations, 218 
printed pages, 237 
Stopframe animations, 210 

printing, 237, 242 
basic options, 238 
commercial, 242 
folded documents, 239 
multiple pages, 239 
of banners, posters, cards, 

thumbnails, 239 
PDF files, 242 
previewing the page, 237 
profiles, 238 
rasterization settings, 242 
special formats, 239 

professional printing, 242 
profiles, 184, 196, 256 

blend, 184 

envelope (Keyframe animation), 
230 

Instant 3D, 196 
pressure, 256 
printing, 238 
tracing, 169 

creating custom, 172 
workspace, 20 

Projection toolbar, 199 
projections, 200 
Pseudo 3D, 199 
Publish as PDF, 14, 242 
QuickShapes, 72 

adjusting, 73 
converting to editable curves, 73 
creating, 72 
resizing, 119 

radial fills, 149 
radial transparency, 158 
Radian blur, 190 
raster (bitmap) images, 163 

changing raster to vector, 170 
rasterization settings for printing, 

242 
reflection maps, 195 
registration, 3 
Replicate, 108 
reshaping curves, 66 
resizing, 118 
Rotate Tool, 57, 120 
rotating 

canvas, 46 
objects, 120 

Roughen Tool, 186 
Rule of Thirds, 47, 110 
rulers, 33 

moving, 33 
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Run Backward (Keyframe 
Animation), 219 

Run Forward (Keyframe 
Animation), 219 

sampling (colours), 144 
saving, 207 

animations, 207 
documents, 27 

Scalable Vector Graphics, 26 
scaling, 33 

of drawings, 36 
storyboard (Keyframe 

animation), 216 
scanning, 180 
Select on Create, 90 
selecting objects, 57 

multiple, 58 
with lasso, 59 

Send to Back, 128 
Serif Metafile Format, 163 
Serif Transparent Video (STV), 

232 
setup, 31 

animations, 206 
documents, 31 

Shadow Tool, 187 
shadows, 187, 189 

applying, 188 
shape text, 95, 97 
shapes 

breaking open, 71 
drawing, 59 
editing, 65 
using QuickShapes, 72 

sharing designs online, 249 
shearing objects, 121 
Size Objects, 118 
SMF, 163 

Smoothness slider, 61 
Snap to Grid, 37 
snapping, 12, 37 

dynamic guides for, 40 
grid, 40 

solid colours, 146 
solid fills, 137 
Solo Mode, 50 
sound (Keyframe animation), 217 

adding, 217 
Spell Checker, 102 
splitting objects, 114 
spray brushes, 87 

special effects, 87 
square fills, 149 
square transparency, 158 
stacking (ordering) objects, 127 
Start New Drawing, 21 
Startup Wizard, 19, 21 
Stopframe Animation, 205 
stopframes 

cloning, 208 
deleting, 209 
inserting, 208 
onion skinning, 209 
renaming, 208 
reordering, 209 

Storyboard tab, 214 
Straight Line Tool, 60, 61 
straight lines, 61 
Studio 

Actions tab, 225 
Align tab, 126 
Brushes tab, 87 
Colour tab, 14, 137, 147 
Easing tab, 229 
Effects tab, 192 
Frames tab, 207 
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Gallery tab, 83 
Layers tab, 129 
Line tab, 141 
Pressure tab, 255 
Storyboard tab, 214 
Swatches tab, 137, 146, 149, 152, 

154 
Transform tab, 114, 118, 121 
Transparency tab, 157 

STV format, 232 
SVG/SVGZ, 26 
Swatch tab, 137, 146, 149, 152, 154 
SWF export, 231 
Synchronize defaults, 51 
system requirements, 15 
tab 

Actions, 212, 225 
Align, 126 
Brushes, 87 
Colour, 14, 137, 147 
Easing, 212, 229 
Effects, 192 
Frames, 207 
Gallery, 83 
Layers, 129 
Line, 141 
Pressure, 255 
Storyboard, 214 
Swatch, 137, 146, 149, 152, 154 
Transform, 114, 118, 121 
Transparency, 157 

tablet, 259 
templates, 20 
text 

artistic, 95 
entering, 96 

blending, 184 

combining, cropping, and 
joining, 124 

converting to editable curves, 73 
defaults, 51 
editing, 97 
entering, 95 
fitting, to path, 12, 101 
formatting, 98 
frame, 95 

entering, 96 
overflow, 99 
positioning in frames and 

shapes, 100 
resizing, 100 
retyping, 98 
setting defaults, 51 
shape, 95 

entering, 96 
spell checking, 102 
Unicode, 97 

textures 
paper, 195 

three colour fills, 149 
three points transparency, 158 
tiling 

Bitmap and Plasma fills, 153 
printing, 239, 241 

tint, 139 
adjusting, 139 

Tool 
Artistic Text, 96 
Blend, 184 
Colour Picker, 144 
Connector, 77 
Crop, 110 
Dimension, 81 
Envelope, 75 
Erase, 117 
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Fill, 149, 152 
Frame Text, 96 
Freeform Paint, 118 
Knife, 114 
Mesh Fill, 154 
Node, 57, 66 
Paintbrush, 87, 89 
Pen, 60, 62 
Pencil, 60 
Perspective, 74 
Pointer, 57 
QuickShape, 72 
Rotate, 57, 120 
Roughen, 186 
Shadow, 187 
Straight Line, 60, 61 
Transparency, 157 

tracing, 169 
colour bitmaps, 169 
creating custom profiles for, 172 
greyscale bitmaps, 169 
logos, 169 
photos, 169 
profiles, 169 

Transform tab 
for precise repositioning, 114 
for precise resizing, 118 
for precise rotation and 

shearing, 121 
transparency 

3D, 194 
effects, 157 
path, 159 
pictures with, 165 

Transparency tab, 157 
Transparency Tool, 157 
TWAIN images 

importing, 180 

tweened objects, 211 
ungrouping objects, 123 
Unicode text, 97 
vector graphics, 163 
vector objects, 169 
Vector-cropped bitmap, 166 
Video export (Keyframe 

animation), 232 
View All Layers, 133 
Web, 205 

animations, 205 
export settings, 243 
previewing in browser, 210, 218 

Weight of line (width), 143 
Welcome to DrawPlus, 3 
windows 

multiple, 50 
Wizard 

Border, 183 
Registration, 3 
Startup, 19, 21 

workspace 
choosing, 20 

zero point, 33 
Zoom blur, 190 
zooming, 43 


	Welcome
	Existing features
	Document
	Design
	Colour and Transparency
	Lines, brushes, and shapes
	Text
	Effects
	Web and Animation
	Export and Print

	New features
	Ease of Use
	Quality
	Design
	Images
	Importing and Exporting
	..and some other enhancements you've requested

	Installation
	System Requirements
	Minimum:
	Recommended:
	Optional:

	First-time install
	Re-install


	Getting Started
	Startup Wizard
	Starting with a design template
	To create a drawing from a design template:

	Starting with a new drawing
	To start a new drawing from scratch using the Startup Wizard:
	To start a new drawing during your DrawPlus session:

	Opening a saved document
	To open an existing document from the Startup Wizard:
	To open an existing document via toolbar or menu:
	Displaying drawings

	Opening other file types
	Opening images as a new document
	To open an image:

	Importing PDF
	To import a PDF:

	Opening Adobe® Illustrator® and Scalable Vector Format files
	To open:

	Opening AutoCAD files
	To open an AutoCAD file:


	Saving your work
	To save your work:

	Closing DrawPlus
	To close the current document:
	To close DrawPlus:


	Working with Pages
	Setting up a document
	To adjust the basic layout of the document (Drawing mode):

	Using the page and pasteboard
	Setting measurement units and drawing scale
	Rulers
	To change the page unit:

	Moving rulers
	Rulers as a measuring tool

	Creating guides
	To create a guide:
	To manage guides:

	Drawing scale
	To change the drawing scale:


	Using snapping
	To turn snapping on and off globally:
	To turn individual snapping controls on and off:
	Using the snapping grid
	To show or hide the snapping grid:

	Snapping with dynamic guides
	To disable dynamic guides and snapping to vertices:


	Viewing pages
	To go to a specific page:
	To navigate pages:
	Zooming
	To zoom to a particular view:


	Adding and deleting pages
	To add one or more new pages:
	To delete one or more pages:
	To duplicate a page:
	To make a page a background for other pages:

	Using design aids
	Rotating your canvas
	To rotate your canvas:
	To reset your canvas:

	Applying the Rule of Thirds
	To apply a Rule of Thirds grid:
	To select the grid:

	Using divine proportions
	To apply a Divine Proportions grid:
	To select the grid (once deselected):

	Isolating an object
	To isolate an object:

	Using multiple document windows
	To create a new document window:


	Updating defaults
	To change which attributes synchronize:
	To switch synchronize defaults off (for manual default control):
	To set object defaults manually:
	Resetting defaults


	Lines, Curves, and Shapes
	Selecting one or more objects
	To select an object:
	Selecting multiple objects
	To select more than one object (multiple selection):
	To select all objects on the page:
	To add or remove an object from a multiple selection:

	Selection using a lasso
	To select using a lasso:


	Drawing lines and shapes
	Drawing lines
	To draw a freeform line:
	To draw a straight line:
	To extend a line:
	To draw a curved line:

	Drawing shapes
	To close an existing curve (with a straight line):
	To close a curve (without new segment):
	To fill an unclosed curve automatically:


	Editing lines and shapes
	Redrawing part of a curve
	To redraw part of a selected curve:

	Reshaping a line
	To reshape a curved line:

	Simplifying or enhancing a line
	To adjust the smoothness of the most recent pencil line:
	To add or delete a node:

	Changing nodes and line segments
	To change one or more nodes to a different type:
	To change a line segment from straight to curved, or vice versa:
	To convert to straight lines:

	Adjusting a shape
	To break open a line or shape:

	Joining lines together
	To join two lines together:


	Using QuickShapes
	To create a QuickShape:
	To adjust the appearance of a QuickShape:

	Converting a shape to editable curves
	To convert an object into curves:

	Applying perspective
	To apply a perspective effect:

	Applying envelopes
	To apply an envelope:
	To remove an envelope:
	To create/edit your own envelope:

	Connectors
	To create a connection:
	To adjust a selected connector's path:
	To edit the selected connector's properties (line weight, colour, weight, style, and end):
	Connector types
	To change the connector type:


	Adding dimension lines and labels
	To draw a dimension:

	Using the Gallery
	To view your Gallery:
	To use a design from the Gallery:
	To copy an object into the Gallery:
	To delete or rename a custom design:


	Using Brushes
	Selecting brushes
	Applying brush strokes
	To apply a brush stroke:
	Setting Brush Defaults
	Editing brush strokes
	To change brush stroke properties:
	To change brush stroke type:
	To change the shape of your brush stroke:



	Working with Text
	Entering text
	To enter new artistic text:
	To create frame text:
	To enter new shape text:
	Working with Unicode text

	Editing text
	Retyping text
	To retype text on the page:
	To create a new line:

	Formatting text
	To format selected text on the page:


	Fitting text to frames and shapes
	Text overflow
	To scale the frame or shape text:

	Positioning
	Resizing

	Fitting text to a path
	To fit text to a path:
	To flow text along a preset path:

	Spell-checking
	To check spelling:
	To change to a different spelling language:
	To check the spelling of a single word:


	Working with Objects
	Copying, pasting, cutting, and deleting objects
	To copy one or more objects to the Windows Clipboard:
	To paste an object from the Clipboard:
	To cut one or more objects to the Clipboard:
	To delete one or more objects:

	Cloning an object
	Making duplicates
	Making multiple copies in a grid
	To replicate an object:

	Applying a transform
	To create a transform:

	Making "in-between" copies of two objects

	Cropping an object
	To crop an object:
	To apply the Rule of Thirds:

	Copying an object's formatting
	To apply one object's formatting to another:

	Moving objects
	To move one or more objects:

	Cutting up objects
	To cut selected objects (freeform or straight line):
	To cut out selected objects using cookie cutters:

	Erasing and adding to objects
	To erase portions of a selected object:
	To add to a selected object:

	Resizing objects
	To resize an object to a fixed aspect ratio:
	To resize QuickShapes:

	Rotating and shearing objects
	To rotate one or more objects around a centre point:
	To change the centre point of rotation:
	To rotate selected object by set degrees:
	To shear or copy shear an object:
	To undo the rotation or shear (restore the original object):

	Flipping objects
	To flip an object:

	Locking/unlocking an object
	To lock/unlock an object:

	Grouping objects
	To create a group from a multiple selection:
	To ungroup (turn a group back into a multiple selection):
	To ungroup multiple groups within a group:

	Combining, cropping, and joining objects
	Aligning and distributing objects
	To align two or more objects:
	To align one or more objects with a page edge:
	To distribute two or more objects:

	Ordering objects
	To change the object's order:

	Working with layers
	To select a particular layer:
	To add a new layer:
	To rename a layer:
	To delete a layer:
	To move a layer in the stacking order:
	To merge a layer:
	Layer Properties
	Managing objects on layers
	To add objects to a particular layer:
	To select objects on a particular layer:
	To select any object on any layer:
	To change an object's or group's name:
	To move an object to another layer:



	Fill, Lines, Colours, and Transparency
	Setting fill properties
	Solid colours
	To apply a solid fill colour via the Colour tab:
	To apply a solid fill colour via the Swatch tab:
	To change a fill's shade/tint (lightness):
	To apply a gradient, bitmap, or plasma fill to one or more objects:
	To edit an object's fill colour(s) and tint:
	To apply no fill:

	Blend modes

	Setting line properties
	Changing line style
	To change line style:
	To select a line end:

	Changing line caps and joins
	Changing line width

	Sampling colours
	To sample colours (via Colour Picker Tool):
	To sample colours (via Colour tab):

	Defining line and fill colours
	Adding colours to the Document Palette
	To add a colour to the Document Palette (from Colour tab):
	To add a new colour (via dialog):
	To add a colour (from a selected object):
	To add a colour (directly from any palette):
	To add colour spreads (using Colour Palette Designer):
	To modify or rename a palette swatch:
	To delete a palette swatch:

	Adding fills to the Document Palette
	To add a gradient, mesh, or plasma fill (from a selected object):
	To add a bitmap fill (from an imported picture):


	Working with gradient fills
	Applying a gradient fill
	To apply a gradient fill (Fill Tool):
	To apply a gradient fill (Swatch tab):

	Editing the fill path
	To adjust the gradient fill path on a selected object:

	Editing the fill spectrum

	Working with bitmap and plasma fills
	Editing the fill path

	Working with mesh fills
	To enable the Mesh Fill Tool:

	Setting opacity
	To apply solid opacity:
	To apply solid opacity (to a fill path):

	Using transparency effects
	To apply gradient or bitmap transparency effects:
	To apply gradient transparency with Transparency Tool:
	Editing gradient transparency
	To adjust the transparency path directly:



	Working with Pictures
	Importing pictures
	To import a picture from a file:
	Notes:

	Using Image Cutout Studio
	To launch Image Cutout Studio:
	Choose an output
	To create an alpha-edged bitmap:
	To create a vector-cropped bitmap:

	Selecting areas to keep or discard
	To select image areas for keeping/discarding:


	Autotracing
	To autotrace a selected image:
	Creating custom profiles
	To save a custom autotrace profile:
	To delete an autotrace profile:


	Applying PhotoLab filters
	Applying filters
	To add a new filter:
	To disable, reset, and delete filters:
	To reorder filters:
	To add a filter directly (without trialling):

	Retouching
	Selective masking
	To apply a mask:
	To edit a mask:

	Saving favourites
	To save and manage favourites:


	Importing scanner images
	To set up your digital device for image acquisition:
	To import pictures from a TWAIN device (i.e., scanner):


	Applying Special Effects
	Creating borders
	To create a border:

	Creating blends
	To create a blend with the Blend Tool:
	Blends in Stopframe animation

	Creating rough edges
	To apply roughening:

	Adding drop shadows
	Applying drop shadows with Shadow Tool
	To change a shadow's colour:
	To remove the shadow from an object:


	Applying 2D filter effects
	Making feathered edges
	To apply 2D filter effects:

	Creating outlines
	Colour Fill
	Feathering
	Blur

	Using 3D filter effects
	To apply 3D Effects:
	3D Bump Map
	2D Bump Map
	3D Pattern Map
	2D Pattern Map
	Transparency
	3D Reflection Map
	3D Lighting

	Applying paper textures
	To apply a paper texture:
	To remove a paper texture:

	Applying dimensionality (Instant 3D)
	To add dimensionality:
	To revert your Instant 3D transform:
	To switch off 3D effects:
	To change Instant 3D display resolution:

	Applying Pseudo 3D
	To apply a Pseudo 3D projection:
	Selecting objects on the same plane:
	To project an object to a different plane:
	Using Advanced Pseudo 3D
	To apply an advanced Pseudo 3D projection:
	Creating a custom projection:
	Saving a custom projection:



	Creating Animations
	Getting started with animation
	To begin a new Stopframe or Keyframe animation (from Startup Wizard):
	To begin a new Stopframe or Keyframe animation from scratch:
	To convert an existing drawing to either animation mode:
	To adjust the basic layout of your animation:
	To save an animation:

	Working with Stopframe animation
	To view the Frames tab:
	To clone the current frame to a new frame:
	To generate a new blank frame:
	To navigate between frames:
	To rename a frame:
	To change frame sequence:
	To delete a selected frame:
	Onion Skinning
	To turn onion skinning on or off:

	Previewing Stopframe animations
	To preview in the Preview window:
	To preview in a web browser:


	Working with Keyframe animation
	Supporting tabs
	Advanced keyframe animation
	Getting started
	Choosing a Page Setup:
	To view the Storyboard tab:
	To insert keyframes:
	To split a selected keyframe:
	To view or edit a particular keyframe:
	To delete a keyframe:

	Keyframe duration
	To set the duration of an individual keyframe:


	Storyboard control
	Adding sound
	To add an audio clip:

	Adding movies
	To add a movie:

	Previewing keyframe animations
	To preview:


	Keyframe object control
	To run object(s) forward/backward:
	To change object placement:
	To change object attributes
	Autorun
	To autorun objects:


	Applying actions (keyframe animation)
	To apply an action to selected object(s):
	To apply action(s) to a keyframe:
	To create custom ActionScript:
	Creating markers
	To set a marker:


	Affecting change over time (keyframe animation)
	To apply an envelope:
	To reset a selected envelope:
	To save your custom profile:
	To delete a profile preset:

	Exporting animations
	Flash SWF
	To export your animation as a Flash file:

	Flash Lite/i-Mode
	To export to Flash Lite/i-Mode:

	Video
	To export animation as video:

	Image
	To export as an animated GIF:



	Publishing and Sharing
	Previewing the printed page
	To preview the printed page:
	To print:
	To cancel Print Preview mode:

	Basic printing
	To set up your printer or begin printing:
	To print:
	To save current print settings as a print profile:

	Printing special formats
	Folded documents
	Printing posters and banners
	To print a poster or banner from a standard size page:

	Printing business cards and labels
	Printing thumbnails
	Multiple pages per sheet
	Tiling

	Publishing as PDF
	To export your document as a PDF file:

	Exporting objects and drawings
	Exporting as image
	To export as an image:

	Defining a region for export
	To define an export region:
	To select the box:

	Dynamic preview
	To change export settings:
	To export via Dynamic Preview:
	To toggle between Normal and Preview Mode:


	Sharing via DRAWPLUS.COM
	Registering for the first time
	Setting up account details in DrawPlus
	Uploading
	To upload your design:



	Pressure sensitivity and pen tablets
	Pressure sensitivity
	via a pen tablet
	via the Pressure tab
	To apply a pressure profile:
	To create a new pressure profile:
	To save a new pressure profile:
	To delete a pressure profile:

	Altering stroke width and opacity with pressure
	To adjust stroke width or opacity with pressure (in Pressure tab):
	To adjust stroke width or opacity with pressure (per Brush):


	Using pen tablets
	Using Pressure Studio
	To launch Pressure Studio:

	Function key assignment
	To customize your function keys:
	To revert to the tablet's default key assignment:



	Index

